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Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be 
construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 
Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© 2015 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe® is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online web site and search for the product manual called HP Service 
Manager Open Source and Third Party License Agreements.

Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.
 l Document Release Date, which changes each time the document is updated.
 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:           https://softwaresupport.hp.com

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:           http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

Support
Visit the HP Software Support Online website at: https://softwaresupport.hp.com

This website provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your 
business. As a valued support customer, you can benefit by using the support website to:

 l Search for knowledge documents of interest
 l Submit and track support cases and enhancement requests
 l Download software patches
 l Manage support contracts
 l Look up HP support contacts
 l Review information about available services
 l Enter into discussions with other software customers
 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal website. This site enables you to explore HP Product Solutions to meet your business needs, 
includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this website is http://h20230.www2.hp.com/sc/solutions/index.jsp
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What's new in this release
This section describes  important changes in this release.

This release also fixes a number of defects. See "Fixed defects" on page 8.

Tip: As of Service Manager 9.33, the Installation Information section of the patch detail page will 
contain a link to a knowledge base article that contains links to all the previous release notes and 
patches. This article enables you to always find the most up-to-date release notes and the latest 
9.3x patches:

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM00705452

Service Request Catalog enhancements
This release introduces the following new enhancement for Service Request Catalog.

SRC allows the "request for" and "callback contact" person to update or cancel the Support 
Requests from the SRC user interface

Support Requests can now be updated or canceled within the SRC user interface.

SRC allows you to cancel the Service Requests from the SRC user interface

Service Requests can now be canceled within the SRC user interface.

Embedded JRE Upgraded (Server, Windows client, and 
Windows client configuration tool)
This patch release upgrades the embedded JRE in the HP Service Manager server, Windows client, and 
Windows client configuration tool.

Server

The server embedded JRE for x86 systems has been upgraded  to version 1.8.0_72.
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Since the Service Manager server does not come with an embedded JRE for non-x86 systems (Solaris, 
HP-UX, and AIX), users using these platforms need to install one of the following JRE1.8 versions and 
make sure server/RUN/jre is a symbolic link pointing to the JRE1.8.

Platform JRE Version

All supported Windows and Linux platforms JRE1.8 (update 72  or greater)

HP-UX JRE1.8 (JRE_8.0.04 or greater)

AIX JRE1.8 (SR2 or greater)

Caution: HP-UX 11.31 supports JRE1.8 (JRE_8.0.04 or greater), whereas HP-UX 11.23 supports JRE 
1.7 only. Currently the highest JRE 1.7 version for HP-UX is 1.7.0.15.

Note: After you upgrade the JRE version on AIX, please check that the LIBPATH variable contains the 
following line: 

$JRE_HOME/lib/ppc:$JRE_HOME/lib/ppc/j9vm

$JRE_HOME is a placeholder for the directory in which the JRE is installed.

Windows client

The Windows client embedded JRE has been upgraded to version 1.8.0_72.

Windows client configuration tool

The Windows client configuration tool embedded JRE has been upgraded to version 1.8.0_72.

Deprecations
The following items are deprecated as of this release.

Service Manager server

 l Novell SUSE Linux Enterprise 10 SP1

Service Manager Windows client

 l Windows 8
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Enhancements
This release includes the following enhancement type fixes.

SRC
CR Problem Solution

QCCR1M2359 SRC does not allow the cancellation of 
Service Requests from the SRC user 
interface.

Now the Service Requests can be 
cancelled in SRC.  

QCCR1E129134 SRC does not allow the "request for" 
person to update/cancel the Support 
Requests  from the SRC user interface. 

Now the "request for" person and 
"callback contact" person can update or 
cancel the  Support Requests in SRC. 

Patch 5 Release Notes
Enhancements
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Fixed defects
This release fixes the following defects.

SRC
CR Problem Solution 

QCCR1E101823 In the Contact Search pop-up window, the Tab key 
does not work properly in Internet Explorer. For 
example, if you set focus to the First Name field 
and then press Tab, the focus goes to the Contact 
Name field. If you press Tab again, the focus goes 
back to the First name field and the Last Name 
field does not have a chance to get focus.

In the Contact Search pop-up 
window, the Tab key now 
works properly in all supported 
browsers. Each focusable 
control on the form can get 
the focus and you can navigate 
through each control using the 
Tab key.

QCCR1E110287 When you open a support ticket and press Tab to 
shift the focus to a specific  field (for example, the 
Description field), the field is highlighted but you  
cannot enter any data until you click inside the 
field. 

When you open a support 
ticket and press Tab to shift 
the focus to a specific  field, 
the field is highlighted and you 
can enter data as expected. 

QCCR1E120787 When a launcher is created with a long name in 
SRC, the title is truncated and  only part of the text 
is displayed. 

Now the title is displayed as a 
tip when you hover the mouse 
cursor over it. 

QCCR1E121115 Text in the Item Description section of the SRC 
catalog detail screen is  displayed with extra 
spaces between lines and paragraphs. 

Now the item description is 
rendered correctly on the SRC 
catalog detail screen. 

QCCR1E122197  When creating a request in SRC using a catalog 
item that has check boxes in the  user selection 
settings, you cannot see the check boxes selected 
or cleared in  SRC request details. If you clear the 
check boxes, the check boxes are invisible.  If you 
select the check boxes, the label is shown with no 
value. 

The check box is shown when it 
is selected. To keep the same 
behavior with other  user 
selections, the check box is 
hidden when it is unselected. 
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CR Problem Solution 

QCCR1E122680 The Interaction ID is truncated in SRC Approval 
Queue when it has 18 characters. 

The Interaction ID label size is 
increased to support 18 
characters.   

Note: The Interaction ID is 
truncated when it has 
more than 18 characters 
and a  tooltip is shown 
when you hover the 
mouse cursor over it.

QCCR1E123401 If a user selection name in a Service Catalog item 
is too long, the name is  truncated on the request 
details page after the service catalog item is  
submitted. 

The user selection name is 
fully displayed now. 

QCCR1E123599 The SRC fulfillment status field is not displayed 
when you view the Additional  Details area of an 
Interaction. 

The fulfillment status is 
displayed in the Additional 
Details area if its value  is not 
null. 

QCCR1E124513 When you hover your mouse on SRC user account 
popup menu, the pointer is Text  Select. 

When you hover your mouse on 
SRC user account popup menu, 
the pointer is Link  Select now. 

QCCR1E124606 When you manually enter a date in a mandatory 
date field in service catalog item  user selections, 
the system displays a This field is required 
error message. 

No error message is displayed 
when you manually enter a 
date in a mandatory date  field 
in service catalog item user 
selections. 

QCCR1E128568 SRC does not support switching from the TSO 
login to the general login under TSO  environment. 

SRC now supports switching 
from the TSO login to the 
general login under TSO  
environment. 
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Mobility
CR Problem Solution 

QCCR1E125134 After you update your Chrome browser to 
version 43, you cannot expand the Queue 
combo box in the top left corner of the main 
page in the Mobile Applications client. 

After you update your Chrome 
browser to version 43, you can now 
expand the Queue combo box in the 
top left corner of the main page in 
the Mobile Applications client. 

QCCR1E125787 After you update your Chrome browser to 
version 43, if you access the Mobile 
Applications client login page and expand the 
language combo box, each item in the drop-
down list is displayed as an empty item.

Now each item in the drop-down list 
is displayed correctly.

QCCR1E126549 After you update your Chrome browser to 
version 44, if you select an item from the 
drop-down list of a combo box in the Mobile 
Applications client, the screen is masked and 
the client stops responding. 

Now the screen mask disappears, 
and you can continue to use the 
client as expected.

Server
CR Problem Solution 

QCCR1E112412 After you make modifications to a 
record and change its group in a 
grouped QBE  list, the focus jumps to 
the first record of the QBE list. 

Now if you make modifications to a record 
and change its group, the record still  retains 
the focus no matter it is in QBE list or in the 
Todo Queue. If you delete  a record, the 
succeeding record becomes the current row. 
If you delete the last  record, the preceding 
record becomes the current row. This 
solution works in the  default QBE List mode. 
However, it does not work if the value of the  
viewrecordlist parameter is set to 0 in the 
sm.ini file. 

Patch 5 Release Notes
Fixed defects
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CR Problem Solution 

QCCR1E116039 After you import the unload file 
QCCR1E106361_SM934_
SRC934p2.unl in SM 9.34, the User 
Selection Template function  is 
enabled. However, when you open a 
service catalog item with multiple 
user  selections and then select one 
or more check boxes of the user 
selections and  move the user 
selections up or down, the check 
boxes become unchecked. 

The check boxes keep the checked status 
after you move one or more user  selections 
up or down in the web client. 

Note: To apply this fix, you must  
additionally configure the 
svcOptionsTemplate.view format by 
following these  steps:

 1. Log on to the Service Manager 
Windows client as a system 
administrator.

 2. In Forms Designer, open the 
svcOptionsTemplate.view format in 
Design mode.

 3. Select the table on the User 
Selections Definition tab.

 4. In the Properties pane,  if the 
Selection Field field is empty, type 
option.names in this field.

 5. Click  OK twice to save your changes.

QCCR1E118284 The linker bg process crashes 
because a Signal 11 error occurs 
in the  getnumber() JavaScript API. 

Now there is no Signal 11 error when the 
getnumber() JavaScript API is called.

QCCR1E120047 The system displays the emailout 
servlet running Process Low 
on Java Memory  error message 
and no longer sends out mails. 

Now this error no longer occurs. 

QCCR1E120459 The Service Manager RTE crashes 
after you create a language 
installer. 

Now the Service Manager RTE runs without 
any exception. 

QCCR1E121003 After an upgrade, the server 
generates large dump files and 
these files consume  almost all the 
available disk space. 

The server no longer generates unnecessary 
dump files. 

Patch 5 Release Notes
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CR Problem Solution 

QCCR1E121716  You cannot enter a time interval 
higher than 23:59:59 (for 
example, 1 00:00:00)  in the 
Duration field of process target 
SLTs. In this situation, the system  
displays the following error 
message:  

Field contains an invalid 
date/time value  

Now you can enter time intervals higher then 
23:59:59 by using the format days  
hh:mm:ss. For example: 1 00:00:00. 

QCCR1E122633  When you click the Select all button 
in the web client, the  
multiselect.selection("rows") RAD 
function returns an incorrect index. 

When you click the Select all button in the 
web client, the  multiselect.selection("rows") 
RAD function returns the same index that is  
returned if you select all the records one by 
one. 

QCCR1E124185 If the external_lb parameter is 
configured in the sm.ini file, both HP 
Connect-It  and HP Service Manager 
Client fail to connect to the Service 
Manager server, and  the following 
exceptions are generated:  

SM Server is running under an 
external load balancer 
environment. Client request  
was intended to send to SM 
Server directly.Could not 
continue the process!

You can now include -external_lb:0 in a 
command when you start a servlet from  the 
operating system command prompt. This 
forces the servlet node not to run in  external 
load balancer mode.   

Only -external_lb:0 can be added to a 
command. -external_lb:1 and external_lb 
are  not recognized in commands. As the 
servlet node does not work in external load  
balancer mode, it rejects any connections 
from a hardware load balancer. 

QCCR1E125697 When you use WebService to 
integrate a third party tool to 
Service Manager and  the tool is 
configured to check the WSDL and 
XSD, the Webservice response is  
incorrect. Specifically, the response 
contains attributes (hasuploadby,  
hasuploaddate, and isNew) that 
are not defined in WSDL. 

When you use WebService to integrate a 
third party tool to Service Manager and  the 
tool is configured to check the WSDL and 
XSD, the Webservice response does not 
contain attributes (hasuploadby, 
hasuploaddate, and isNew) that are not  
defined in WSDL. 
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CR Problem Solution 

QCCR1E128509 After an interaction/OCML is closed, 
Service Manager returns to the 
wrong page of  the inbox and 
displays the wrong record. 

After an interaction/OCML is closed, Service 
Manager now moves the focus to the  next 
record of the current page. 

QCCR1E132443  The tab for a problem record 
disappears after you click an 
external URL link. 

Now the tab for a problem record does not 
disappear after you click an external  URL link. 

QCCR1E132700 The IR Regen has already been 
completed in a customer's 
production server.  However, the 
customer cannot use text search. 
The system displays the following  
error:   

Query request not processed 
because of previous I/O Error 
on file ir.probsummary  
(cc.search,select)   

Command sm -util > vrir against 
probsummary shows failed.   

Customer has about 296,000 
records in the probsummary table 
which generated  approximately 
1.5M scirexpert entries with the 
ir.probsummary names. 

Now the text search works fine, and VRIR will 
not report any error when checking  upon a 
successfully finished IR REGEN. 

QCCR1E117221 When the system throws many Java 
exceptions, JVM GC does not collect 
the memory of these Java 
exceptions due to an RTE code 
design limitation. Therefore, the 
Java exceptions accumulate and an 
out-of-memory error occurs. 

Now when the system throws many Java 
exceptions, these exceptions are released by 
the RTE code and no more Java memory leak 
errors occur.
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Web client
CR Problem Solution 

QCCR1E80251 In the web client, users can only see the latest 
50 messages in the Message and  Alert window. 

Administrators can configure the 
maxMessageNumber parameter 
in the  webtier.properties file so 
that users can see up to 500 
messages in the Message  and 
Alert window. The default value 
of this parameter is 50, and the 
maximum  allowed value is 500.   

Note: When the number of 
new messages ("N") is larger 
than 99, "N.." is displayed  in 
a red circle on top of the 
message icon.

QCCR1E114830  Suppose a Comfill control and a Subform control 
share the same "input" field. The  Comfill control 
has the Auto Complete feature enabled, 
whereas the Subform  control has the Virtual 
Join feature enabled. If you change the Comfill 
value by  using the Auto Complete drop-down 
list, the content of the "input" field in the  
Subform is not refreshed. 

Now the content in the Subform 
is refreshed accordingly. 
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CR Problem Solution 

QCCR1E116039 After you import the unload file QCCR1E106361_
SM934_SRC934p2.unl in SM 9.34, the User 
Selection Template function  is enabled. 
However, when you open a service catalog item 
with multiple user  selections and then select 
one or more check boxes of the user selections 
and  move the user selections up or down, the 
check boxes become unchecked. 

The check boxes keep the 
checked status after you move 
one or more user  selections up 
or down in the web client. 

Note: To apply this fix, you 
must  additionally configure 
the 
svcOptionsTemplate.view 
format by following these  
steps:

 1. Log on to the Service 
Manager Windows 
client as a system 
administrator.

 2. In Forms Designer, 
open the 
svcOptionsTemplate.vi
ew format in Design 
mode.

 3. Select the table on the 
User Selections 
Definition tab.

 4. In the Properties pane,  
if the Selection Field 
field is empty, type 
option.names in this 
field.

 5. Click  OK twice to save 
your changes.

QCCR1E116845 If you set focus to a read-only field and press 
the backspace key, the page  refreshes 
unexpectedly. In addition, if you continue 
pressing the backspace key  for multiple times, 
you are logged out in some occasions. 

If you set focus to a read-only 
field and press the backspace 
key, nothing  happens now. 

Patch 5 Release Notes
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CR Problem Solution 

QCCR1E119179  Sometimes the Find button of a Comfill does not 
work. For example, in the detail  page of a record 
A, you may click the Find button of a Comfill to 
show its detail  information (record B), and you 
may then perform a certain operation to show  
record C. If record C shares the same form 
name as record A, the Find buttons of  the 
Comfills on this page sometimes do not work. 

Now the find button of a Comfill 
always works. 

QCCR1E119451 The Calendar pop-up always shows Sunday in 
the first column when you log on to  Service 
Manager by using SSO/TSO, no matter how the 
parameter startDayofWeek is  configured in the 
web.xml file.   

The Calendar pop-up shows the 
first column based on the 
startDayofWeek  configuration in 
the web.xml file when you log on 
to Service Manager by using  
SSO/TSO.   

QCCR1E120585 If the content to be displayed in an HTML Viewer 
contains a link, and you set an  unquoted string 
for the href attribute of this link (for example,  
<href=http://abc.com>), you are unable to print 
a form that contains this HTML  Viewer in the 
web client. 

Now you can print the form 
successfully. 

QCCR1E120660 If you save an operator record without changing 
the password in the web client, sometimes the 
system displays the following error message: 

 The entered password exceeds the 
maximum length allowed.

Now the record is saved 
successfully without any 
password related error 
messages.

QCCR1E121083 When you resize the browser window so that it 
becomes too small to show all  Notebook tabs in 
a form, the Notebook scroll buttons are not 
displayed after the  form is loaded for the first 
time. You can only resize the browser window to  
display all Notebook tabs. 

Now you can see the scroll 
buttons when a form with many 
Notebook tabs is loaded  for the 
first time. 

QCCR1E121191 Suppose you added a User Selection with display 
type of Pick List of Radio  buttons to a catalog 
item, and then set a very long label for one of 
the radio  buttons. When you order this catalog 
item in the web client, the display of the  long 
radio label exceeds the border of the radio 
group. 

Now the long radio label is 
wrapped and is displayed inside 
the border of the  radio group. 
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CR Problem Solution 

QCCR1E121718  Some Service Catalog item images are much 
smaller than others on the web client  in Internet 
Explorer 11. 

Service Catalog item images are 
displayed in the same size on the 
web client in  Internet Explorer 
11. 

QCCR1E121734 If you use a field which is named "groups" for 
the "input" property of a record  list column, the 
record list hangs when you access the web 
client. 

The record list is loaded 
successfully when you access the 
web client. 

QCCR1E123193  When you fill all dependent pull-down lists and 
click a higher level field, the  lower level 
dependent fields are cleared. 

When you click a higher level 
field, the content of the lower 
level fields is  kept on the form as 
long as the higher level field is 
not changed. 

QCCR1E127148 When you use the Comfill widget in web client, 
each keystroke triggers a Data  Changed Event 
and it is difficult to enter data.  

When you use the Comfill widget 
in web client, the keystroke no 
longer triggers a  Data Changed 
Event. 

QCCR1E127385  When a user is logged out after a long query due 
to the socketReadTimeout  exception in the 
Service Manager web client, the user session is 
still active  regardless of the session-timeout 
value in the web.xml file. 

When a user is logged out due to 
the socketReadTimeout 
exception, the session is  ended 
right away. 

QCCR1E128212 The list is displayed as blank when the column 
value is array.  

The list can be displayed 
normally now.  

QCCR1E128498 The web client displays the Http status 500 
error when the unpackWARs parameter  is set to 
false in Tomcat.

Web client can be deployed and 
accessed without errors even if 
the unpackWARs  parameter is 
set to false in Tomcat.

QCCR1E128843 In the Service Manager web client with French 
localization, an apostrophe(') is  displayed as 
"&#39;" when $G.show.menu.forms is enabled. 

Now the apostrophe is correctly 
displayed in this case. 

QCCR1E130384  When you use web browsers that support 
HTML5, the number of attachment files that  you 
can upload does not match the value of the 
maxattachmentcount parameter. 

Now you can upload files as 
defined by the value of the 
maxattachmentcount parameter 
in this case. 
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CR Problem Solution 

QCCR1E132882 After you log on to the Service Manager web 
client by using Internet Explorer, you can press X 
to clear the values in comfils and then click Fill 
for new queries. However, the values in the 
fields are not cleared and are still used for the 
new queries. 

After you log on to the Service 
Manager web client by using 
Internet Explorer, you can press 
X to clear the values in comfils 
and empty the fields for the 
queries.

Windows client
CR Problem Solution 

QCCR1E117587 If you configure the Windows client with 
the HP Service Manager Client  
Configuration Utility to hide server 
parameters, the Connections dialog box 
is  not automatically displayed when you 
start the Windows client. 

When you start the Windows client, the 
Connections dialog box is automatically  
displayed, even after you configure the 
Windows client with the HP Service  
Manager Client Configuration Utility to 
hide server parameters. 

Patch 5 Release Notes
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Known problems, limitations, and workarounds
This software release has the following known issues and limitations. This is a cumulative list of known 
issues and limitations in Service Manager, including those that are already documented in previous 
release notes.

Issues  in Service Manager 9.31 and patches
Global ID Problem Workaround

QCCR1E63663 The Service Manager client loses 
connectivity during JavaScript 
execution of the file.list RAD 
application.

No workaround available.

Created a knowledge article (KM1166532), 
which states that Service Manager does 
not currently support calls from JavaScript 
on RAD applications that use the rio/fdisp 
panels.
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Global ID Problem Workaround

QCCR1E57385 When Service Manager is running 
on Unix, the legacy listener may 
log intermittent signal 11 errors 
upon CIT initial connectivity test if 
exec-shield is not set properly.

Use one of the following solutions to work 
around this issue.

Solution 1:

Connect Connect-It to the Web Services 
connector instead of the Legacy Listener 
connector.

Solution 2:

Before connecting Connect-It to the Legacy 
Listener connector, do the following:

 1. Add  usethreading:0 in the sc.ini file, 
which is located in <Service Manager 
server installation 
path>\LegacyIntegration\RUN.

Note: For 64-bit RedHat Linux 
servers only, you can 
alternatively run the following 
shell commands as root:

# sysctl -w kernel.exec-
shield=0

# sysctl -w kernel.randomize_
va_space=0

 2. Start the legacy listener.

Patch 5 Release Notes
Known problems, limitations, and workarounds
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Global ID Problem Workaround

QCCR1E67491 When the collation of the db 
instance is Chinese_PRC_BIN, 
Web service clients fail to 
connect to Service Manager. Only 
ASCII operator names are 
supported, so only ASCII operator 
names can be used. 

Note: This issue only exists in Web 
service integrations. Therefore, the 
Service Manager clients do not have 
this problem.

When Service Manager is handling an 
incoming SOAP request, the authorization 
string is decoded by BASE64Decoder. 
Service Manager uses the decoded string 
value to construct a UTF-8 string that is 
used in the RTE. However, the 
authorization string is in the header and 
Service Manager does not know the 
charset or encoding of the underling string 
value, which is BASE64 encoded. 

Therefore, if the underlying string value is 
not UTF-8, this problem will occur. In 
Service Manager, when fetching an 
operator record from the database, no 
matter what collation the database uses, 
the operator record finally will get a UTF-8 
operator value. However, even if users put 
the same value in the authorization 
header, the operator name may differ 
because of the charset/encoding issue. 
Because of this, the operator will fail to log 
on.  

This is a limitation of Service Manager. Do 
not use non-ASCII characters in operator 
names. Created a knowledge article 
(KM1442479) to document this limitation. 

QCCR1E75182 HTML email truncates the body of 
the message and sends the HTML 
code without translating it.

When the content of an HTML email 
template exceeds 8192 bytes in size, the 
content will be truncated and displayed as 
HTML code.   

Make sure your HTML email templates do 
not exceed this size limit.

Patch 5 Release Notes
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Global ID Problem Workaround

QCCR1E77563 Signal 11 error is received when 
calling the toXMLString() routine 
of the Users object. 

No workaround is currently available.

QCCR1E88222 An unload file that is exported 
from an Oracle to an SQL Server 
database fails to import when 
the unload file already contains a 
RECORD_KEY field and the length 
of first unique key exceeds the 
db limitation.

This request is caused by the product 
running in an unsupported configuration. 
Change to a documented and supported 
configuration. If the problem still exists in a 
supported environment, contact HP 
Support.

To work around this issue, do not use 
"RECORD_KEY" as a SQL Name for a field in 
dbdict.  This field name is reserved by 
Service Manager.  To do this, follow these 
steps:

 1. Enter dbdict in the Service Manager 
command line box, and then press 
Enter.

 2. Open the problematic dbdict which 
has the "record.key" field defined.

 3. Select the "record.key" field, and then 
change the SQL Name from "RECORD_
KEY" to anything else.

QCCR1E74808 After clicking the Cancel button 
in the Condition Editor from the 
Workflow Editor, the current tab 
sometimes becomes a blank 
screen and the tab cannot be 
closed.

No workaround is currently available.

QCCR1E105052 In Task Planner, the tooltip of a 
task displays the change phases 
with their names instead of their 
display names.

No workaround is currently available.
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Issues  in Service Manager 9.32 and patches
Service Manager  Issues

Global ID Problem Workaround

QCCR1E64377 In the web client, when a 
Configuration Item (CI) record is 
opened, the CI label does not show 
(or only shows for the first time) in 
the CI Visualization (Relationship 
Graph). This issue occurs only when 
JRE 6 is used.

As Oracle has fixed this Applet issue, 
JRE 6 customers need to upgrade their 
JRE to the latest JRE6 or JRE7 on the 
machine that runs Internet Explorer or 
Firefox in order for CI Visualization to 
display CI labels correctly.

QCCR1E95725 Due to a known issue in JDK (bug 
id:7196513), CI icons are not 
displayed correctly in Firefox when 
Httponly cookies are enabled in the 
web application server. 

When Httponly cookies are enabled, 
users can only use Internet Explorer 7 
or higher for CI icons to display 
correctly.  As Oracle has fixed the 
Httponly cookie issue as of JDK 7u6, 
users need to install the latest 32-bit 
JRE (7u6 or above) on the machine that 
runs Internet Explorer 7 or higher. 

Note: In Service Manager 9.33,  
users can only use Internet 
Explorer 8 or higher for CI icons to 
display correctly.

QCCR1E95963 An error occurs when loading a 
dbdict twice in an unload file. The 
two dbdict records have the same 
name, but different key types:  the 
first one has unique key, while the 
second's key type is primary key. 

Do not export to an unload file a dbdict 
record whose key type has changed. 

Patch 5 Release Notes
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Global ID Problem Workaround

QCCR1E97260 When SSL is enabled between the 
web application server and Firefox, a 
ClassNot found Exception error 
displays in the workflow section of 
the Change form. This issue does not 
occur in IE or in Firefox without SSL 
enabled.

There are two workarounds:

 l Use Internet Explorer instead of 
Firefox. 

 l If using Firefox, import the client 
certificate into the Java console on 
the end user's machine. Here are 
the steps for Windows 7:

 a. Open Control Panel, and i n the 
Control Panel Search box enter 
"Java Control Panel".

 b. Double-click the Java console 
icon to open the Java console.

 c. On the Security tab, click 
Manage Certificates ....

 d. On the Certificates window, 
select certificate type: Client 
Authentication, and click 
Import.

 e. Follow the wizard and import 
the client user's certificate.

QCCR1E97492 Clicking the Back button on the CI 
Visualization page (which opens 
when you click More > Expand CI 
Visualization  in a CI record) causes a 
Firefox crash.

No workaround is currently available.

QCCR1E97603 If a format that contains a button 
with Enable condition is created or 
modified by using a Service Manager 
9.31 patch 1 server, when using it in 
Service Manager 9.31 GA or earlier, 
the client crashes. However, formats 
created by using the Service 
Manager 9.31 GA or earlier server 
work fine.

Upgrade both of the Service Manager 
server and client to the same patch 
level: Service Manager 9.31 patch 1 or 
later.
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Global ID Problem Workaround

QCCR1E94657 When PDCP4 is applied, the first 
group on the form is not shown in 
the Jump Address drop down list.  

Move the scroll bar to the top-most 
position and then you will see the first 
group.

QCCR1E97856 In a single-line text field, some 
special characters whose HTML code 
is &#x...; (where ... stands for a hex 
number) are not represented as 
their original format. Instead, they 
display as &#x...;. However, such 
characters are represented as the 
original format in other widgets 
(textarea, label, message panel, and 
so on).

No workaround is currently available.

QCCR1E93604 The HTTP Response Code is 200 
instead of 400 when a RESTful 
request uses an invalid sort field 
separator (for example, a plus 
symbol).

Use a valid sort field separator. 

QCCR1E94204                     Because of the incorrect status, the 
operation could not proceed after 
merging a record.

Reset the status of this record (for 
example, reopen the closed record) and 
perform the last operation again.

QCCR1E94206 The last operation could not be 
repeated after merging a record 
because the  button for the last 
operation disappears. 

Reset the condition for the button in 
this record, for example, Reopen the 
closed record, and perform the last 
operation again.

QCCR1E96353 RESTful API: An incident record is 
successfully resolved when posting 
an incident resolve action with a 
blank "ClosureCode" and "Solution".

Validation is not performed for the 
fields. 

To work around this issue, validate 
them at the RESTful client side, or    
manually add validation for the fields to 
the format control.

Patch 5 Release Notes
Known problems, limitations, and workarounds

HP Service Manager (9.34) Page 25 of 68



Global ID Problem Workaround

QCCR1E96391 Restful API: Results are in the wrong 
order when sorted by an array field.

This issue occurs because the  
Service Manager RTE does not 
support sorting by array fields. A list 
is returned without any error 
message.

No workaround is currently available.

QCCR1E97898  Restful API: A 400 Bad Request error 
occurs when a RESTful API request is 
a cross-table join query.

The RESTful API framework supports 
simple queries and Service Manager 
native queries.  

Currently RESTful API framework does 
not support cross-table SQL queries.   

QCCR1E98320 When a record is removed after 
being read, the Merge function still 
allows the user to merge the record 
and the user's input is lost. 

No workaround is currently available.

QCCR1E98227 In Approval Delegation wizard, go to 
another page (do not change the 
delegation module) after choose the 
operator to delegate in "Select 
Approval Groups" page, then back to 
"Select Approval Groups" page again. 
You will find a blank line is displayed 
in the right table, instead of the 
operator record.  

This is only a display issue, and will not 
impact the functionality.  If you need to 
remove the operator from the 
delegation list, choose the blank line, 
and then click the remove icon; 
otherwise the operator will be 
successfully delegated once you save 
the update. 

QCCR1E98576 When there are conflicted updates 
on system fields, the system displays 
the message "The conflicted fields 
cannot be merged. Reload the 
record.", whereas the Merge  button 
is available. Actually, the merge 
function should not be available in 
such case. 

Ignore the Merge button. Reload the 
latest record to edit this record again.

Patch 5 Release Notes
Known problems, limitations, and workarounds

HP Service Manager (9.34) Page 26 of 68



Global ID Problem Workaround

QCCR1E98398 When you are updating a record and 
adding attachments to this record, if 
your updates conflict with another 
users' updates or the updates of a 
background process, the 
attachments will be lost after either 
automatic or manual merge.

After automatic or manual merge, add 
the attachments again before saving 
the merged result of the record.

QCCR1E98411 SRC failed to retrieve service catalog 
items from Service Manager on 
upgrade from Service Manager 7.11 
to Service Manager 9.32.

In the svcCatalog dbdict, the id.attach 
field is character type, which should be 
number type. The id.attach field is an 
alias of the id field in the svcCatalog 
table.

To fix the issue, change the field type 
using the Dbdict Utility.

QCCR1E98618 Subcategory data on the Incident 
form is not available after upgrading 
from ServiceCenter 6.2 to Service 
Manager 9.32.

Subcategory data is not upgraded.

If necessary, manually add the 
subcategory data.  

 1. Enter db in the Service Manager 
command line box.

 2. In the Table field, enter 
subcategory, and click Search. 

 3. For each Catagory in the dropdown 
list, add the following Areas (enter 
a value in the Area field and click 
Add):  access, data, failure, 
hardware, performance, and 
security.
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Global ID Problem Workaround

QCCR1E98475 With Process Designer Content Pack 
9.30.3 applied, the Merge 
functionality does not work when a 
user clicks Save & New in an 
interaction record opened through a 
search. 

 1. Open an interaction through a 
search.

 2. Update the Title.

 3. Another back-end process has 
updated the Title to another 
value.

 4. Click Save & New. An error 
occurs: This record has 
changed since you selected 
it.

You cannot perform Merge for 
the conflicted updates as 
expected.

If you encounter the error "This record 
has changed since you selected it." 
when clicking the Save & New button 
on an interaction opened through a 
search, to avoid abandoning your 
updates, do not use the Save & New 
button to save your updates; instead, 
first click the Save button to save your 
updates with the merged result, and 
then register a new interaction from 
the navigation menu.

Service Request Catalog Issues

Global ID Problem Workaround

QCCR1E90074 When entering a search string in 
Service Request Catalog, auto-
complete does not work if the 
browser's preferred language is set 
to an East Asian language (for 
example, Simplified Chinese).

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E98339 Custom fields do not load the 
DEFAULT company value when the 
checkout panel is empty for one of 
the three checkout panels of your 
company.

After upgrade, you should manually 
add the same structure configuration 
of the DEFAULT company for the 
empty checkout panel of your 
company. For example, before 
upgrade, you, as an SRC administrator, 
only defined custom fields for the 
Service Catalog checkout panel for 
your company. After upgrade to 
Service Manager 9.32, if you want to 
use the support checkout panel and 
generic support checkout panel in SRC 
correctly, you need to manually add 
OOB configurations for the Support 
Catalog  and Generic Support checkout 
panels, which you can copy from those 
panels of the DEFAULT company.

QCCR1E103491 When SRC starts in FIPS mode, JCE 
cannot authenticate the provider 
JsafeJCE.

Replace cryptojce-6.1.jar and 
cryptojcommon-6.1.jar in the SRC .war 
files with those from the encryptor 
tool folder in the same release 
package.

Issues  in Service Manager 9.33 and patches
Global ID Problem Workaround

QCCR1E100136 After the installation of a language 
pack, the Windows client, if running on 
an Arabic Windows 2008, displays the 
tooltips of the 'Added' and 
'Forced'/'Updated' columns in the 
content pack results as reversed. 

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E101782 In Trusted Sign-On (TSO) mode, if users 
log in to the web client with Simplified 
Chinese in Internet Explorer 10 running 
on Windows 8 or Windows 2012, the 
web client still displays in English 
instead of in Simplified Chinese.

No workaround is currently available.

QCCR1E103847 An arrow connector in a Process 
Designer workflow might be 
misaligned when the destination phase 
is vertically too close to another phase 
(this problem was introduced in 
Service Manager 9.33 patch 1 revision 
1).

To resolve the issue, move the 
destination phase away enough from 
the adjacent phase.

QCCR1E103858 It displays auto-open tasks in the task 
planner window  (this problem was 
introduced in Service Manager 9.33 
patch 1 revision 1).

No workaround is currently available.

Issues in Service Manager 9.34 and patches
Global ID Problem Workaround

QCCR1E105375 Service Request Catalog does not 
allow approval delegation for the 
Time Period module. 

No workaround is currently available.

QCCR1E106074 When you add custom multi-text 
fields to the Service Checkout page, 
the fields are not displayed 
correctly on the Resubmit page on 
an iPad.

No workaround is currently available.

QCCR1E107572 When you use the arrow keys to 
move up, down, left, and right 
through cells, JAWS reads "Not in 
the table" incorrectly. 

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E107573 When you put the focus on a 
column header after you switch the 
mode to table layer, JAWS reads 
the names of the first column 
header to the column header 
currently in focus incorrectly.

No workaround is currently available.

QCCR1E107712 In Internet Explorer 11, pressing F1 
does not bring up the Service 
Manager help information.

To work around this issue,follow these 
steps:

 1. Start Internet Explorer 11 from a 
desktop computer, and then log in 
to Service Manager.

 2. Press Alt to access the menu bar in 
Internet Explorer. 

 3. In the Tools menu, select 
Compatibility View settings. 

 4. A dialog box appears, in which the  
"Add this website:" field is 
prepopulated with the host name or 
IP address of your webtier host. 
Click Add to add the website to the 
compatibility view list.

 5. Click Close. The Service Manager 
web page refreshes and opens in 
compatibility mode.

QCCR1E107983 In Google Chrome, you are unable 
to use the Tab key to move the 
focus to or off the HTML Editor.

No workaround is currently available.

QCCR1E108558 When "Virtual PC cursor" is enabled, 
JAWS reads a group name three 
times when you expand the group.

No workaround is currently available.

QCCR1E109151 The grouping grid changes to a 
paging grid when you sort a table in 
the "Select a Time Period category" 
page.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E109390 Revisions cannot be added when 
you apply PDCP4 production data to 
Service Manager 9.34 applications 
that were upgraded from Service 
Manager 9.32 applications.

No workaround is currently available.

QCCR1E109577 When you log in to the web client by 
using Internet Explorer 8 for the 
first time, all the characters are 
displayed in an italic font.

Refresh the page in Internet Explorer.

QCCR1E110285 When JAWS 15 runs in Internet 
Explorer 10 or 11, the focus does 
not return to the correct radio 
button when you press Shift+Tab.

No workaround is currently available.

QCCR1E105370 The Quick Jump component is not 
displayed in certain screen 
resolutions.

No workaround is currently available.

QCCR1E110695 The MySM details page is not 
displayed in Hebrew or Arabic.

No workaround is currently available.

QCCR1E110784 Sortable column headers for 
editable tables do not have a sort 
icon.

No workaround is currently available.

QCCR1E110085 JAWS reads the words "read only" 
when the focus is on a language 
combo box.

No workaround is currently available.

QCCR1E110343 The Auto Complete function does 
not work for some fields of the 
timeperioddefine format. 

No workaround is currently available.

QCCR1E111031 The customized Accessible 
Description for the recordlist table 
in a wizard cannot be read by JAWS.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E111202 When JAWS13 is working with Asian 
languages such as Chinese, 
Japanese or with the Arabic 
language, the "System Navigator" 
and "Pagination" navigations 
cannot be listed in "Landmarks."

No workaround is currently available.

QCCR1E111084 You cannot use the keyboard to 
operate on a List Builder control 
when JAWS is running.

No workaround is currently available.

QCCR1E109267 The Label of the Parent Record 
field cannot be displayed correctly 
when saving an incident record.

No workaround is currently available.

QCCR1E110722 Accessibility to the Time period 
rules table and the Time period 
occurrences table is not good on a 
time period record detail form. 

No workaround is currently available.

QCCR1E112188 If a Comfill field has Auto Complete 
enabled and a data change event 
(not 0) defined, and a post 
expression/post JavaScript is 
defined for the link for this field, 
the data change event may not 
work.

Do not enable Auto Complete for the 
Comfill field.

QCCR1E110332 Calendar and Timeperiod in the 
Module drop-down list item on the 
SecArea Search page are not 
translated.

Search for "securityModules" in the 
global list, and then manually add 
translated strings  for the target 
language.

QCCR1E111326 Cannot open timeperiod and entry 
records  in Embedded Calendar in  
Internet Explorer 11. 

Use an older version of Internet Explorer 
or use a different browser such as 
Firefox or Chrome.
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Global ID Problem Workaround

QCCR1E111994 The Timeperiod Manager cannot 
see the Approval Definition menu 
when the system has no Process 
Designer content pack applied.

To work around this issue,follow these 
steps:

 1. Log in to Service Manager Windows 
client as a system administrator.

 2. Type menu in Service Manager 
Command line, and then press 
Enter.

 3. Type timeperiod in the Menu 
Name field, and then click Search.

 4. Locate the row with the  description 
of Approval Definitions.

 5. Remove and jscall
("security.hasRight", "Common 
Configuration","view")=true" 
from the Condition field.

QCCR1E112097 The Option menu is overlapped by 
full calendar in the Service Manager 
accessible web client.

No workaround is currently available.

QCCR1E111131 Calendar and Timeperiod in the 
Module drop-down list are not 
translated in the Security Area 
Search page. To see this issue, 
follow these steps:

 1. Log in to the web client with a 
non-English language. 

 2. Go to System Administration 
> Security > Security Area. 

 3. Click the "Module" drop-down 
list. 

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E119985 When you are updating an Incident, 
if you input an invalid date time 
value to the Outage Start or the 
Outage End field, you cannot close 
this incident tab by clicking the 
Cancel button. The same problem 
also happens when you are opening 
a new Incident,  opening a new 
Change, or updating an existing 
Change.  

Correct the invalid input before you click 
the Cancel button.

QCCR1E120076 On the wizard page of Approval 
Delegation > Set Delegate, when 
you input an invalid date time value 
to the Valid From or the Valid To 
field, the value will be cleared after 
you click the Next button. 

No workaround is currently available.
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Backup and backout instructions
In case you need to restore your HP Service Manager system to its original state after installing the 
component patches in this release, make necessary backups before each patch installation. If a rollback 
is needed, follow the backout instructions.

Server
Backup

Before you apply the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.34\Server.

Note: If you have a horizontally scaled system, be sure to back up the server installation folder for 
each server instance.

Backout

Service Manager has supported FIPS mode since version 9.32. To run Service Manager in FIPS mode, you 
must upgrade your database to the 256-bit AES encryption algorithm. Once you change all of the 
encrypted fields to use the new 32 character encryption you cannot roll back the RTE and still read the 
encrypted data.

After installing the patch, do the following to backout:

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because the 
version of the embedded Tomcat may have dependency on a specific server version.

Note: If you have a horizontally scaled system, make sure that every server instance is 
replaced with its  backup.
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 4. If you have also loaded platform unload files required for your server changes, you must also roll 
back the application changes made by the unload files. See "Applications" on the next page.

 5. Restart the Service Manager server.

Web tier
Backup

Before deploying the new web tier, make a backup of the following items:

 l web.xml

 l application-context.xml

 l log4j.properties

 l splash screen

 l style sheets

 l <Customize-Folder>/config/webtier.properties (where, <Customize-Folder> is the folder specified in 
the customize-folder parameter in the web.xml file.)

Note: This item is only for version 9.34P2 or later.

 l any other customizations you made, including your webtier-<version>.war (webtier-ear-
<version>.ear) file.

Backout

To roll back to the old web tier, follow these steps:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.
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Windows client
Backup

To backup  the  Windows client, follow these steps:

 1. Make a backup of your Windows client home folder, for example, 
C:\Users\<username>\ServiceManager. Your connections and personalized settings are stored in 
this folder.

Note: This is the out-of-the-box home directory, and could differ from yours if you made 
changes  to <Client>\configuration\config.ini file. If so, back up the files from the 
location specified in that file.

 2. Make a backup of your certificate configuration files if any (Window > Preferences > HP Service 
Manager > Security). For example, your CA certificates file and client keystore file. 

Note: For version 9.34P2 or later, make a backup of the keystore password preference file: 
<workspace 
dir>\.metadata\.plugins\org.eclipse.core.runtime\.settings\com.hp.ov.sm.client.eclipse.base.p
refs.

Backout

To roll back to the old Windows client, follow these steps:

 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

Applications
If you plan to upgrade your applications to this release level, make a backup of your database before 
the upgrade, in case you need to restore your database after the upgrade. Creating a backup of the 
entire database and restoring the database if needed is a better approach for a full applications 
upgrade.
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If you plan to load individual unload files in this release, follow the backup and backout instructions 
below.

Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended 
to use Unload Manager to make a backup of the files to be modified by an unload file, because 
Unload Manager can create a backup of your old data during the installation of the unload; if your 
application version is other than any of these, Unload Manager is not available and you can use 
Database Manager instead. 

To use Unload Manager to make a backup, follow these steps:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of 
the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup, follow these steps:

 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse to 
the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this unload.

See the following figure for an example.
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This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict record 
of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the Search 
button.
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 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.

 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in Database 
Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Continue to follow  steps 3 through step 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is not 
available in your application version) to roll back to your old data, as described in the following.

To roll back to your old data using Unload Manager, follow these steps:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click Next. 
Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager, follow these steps:
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 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.

 3. Click Load FG.

SRC
Backup

Before deploying new SRC war package, back up the following files if they have been customized:

 l WEB-INF/classes/applicationcontext.properties

 l WEB-INF/classes/lwssofmconf.xml

 l WEB-INF/classes/cacConfiguration.properties

 l WEB-INF/web.xml

 l Custom.properties

 l secure/configuration folder

Backout

To roll back to the old SRC, follow these steps:

 1. Delete or uninstall the existing SRC.

 2. Clear the cache of your web application server.

 3. Redeploy the old SRC war package.

 4. Restore your old customizations.

Knowledge Management search engine
To back out your Knowledge Management (KM) search engine changes, make a backup before your KM 
patch installation.
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Note: Keep in mind that you also need to roll back KM-related server side and application side 
changes. For details, see the Server and Application backup and backout Instructions.

Backup

Before applying the KM patch and upgrading the JDK and KM embedded Tomcat, do the following:

 1. Make a backup of the search engine installation folder. For example, C:\Program Files\HP\Service 
Manager 9.34\Search Engine Backup.

 2. Make a backup of the files to be modified by the unload files in the KM patch.

 3. Make a backup of your schemastub.xml file under the <SM server>/RUN/km/styles/ directory .

Backout

After installing the patch, follow these steps to backout:

 1. Stop your KM search engine.

 2. Remove the existing search engine installation folder.

 3. Copy the backup folder back.

 4. Rollback the previous JDK installation and change the JAVA_HOME environment variable back.

 5. Be sure to roll back KM related changes on the Service Manager server and application sides, 
including the kmsolr unloads files and the server's schemastub file.

 6. Restart your KM search engine.

 7. Perform a full re-indexing on all of your knowledgebases.
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Installation notes
This section provides instructions on installing each component in this patch release. You can also refer 
to the Service Manager 9.34 Upgrade Documentation Center, which is available to download from the 
following HP Software Manuals website: 

https://softwaresupport.hp.com/km/KM01042968

Before you proceed, HP recommends that you consult the latest Service Manager 9.34 Support Matrix 
and the Compatibility Matrix for Service Manager Applications Content. These are available at the 
following website:

https://softwaresupport.hp.com/group/softwaresupport/support-matrices

For more information, see "Service Manager support matrix and applications content compatibility 
matrix" on page 66.

Digital signature notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has been 
updated to use a new VeriSign root certificate. On a Windows system that does not have the new 
VeriSign root or intermediate certificate installed, when the user right-clicks the file and then goes to 
Properties > Digital Signatures > Details, the following verification error is displayed: 

The certificate in this signature cannot be verified.
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To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as 
documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140.

Server update installation
The server update for your operating system consists of a compressed file, sm9.34.5003-P5_<OS>.zip 
(or .tar), which contains updated files of the HP Service Manager server. These files add to or replace 
the files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin, legacyintegration, and platform_
unloads directories. 

Note: If you use an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 is required for 
Service Manager 9.30p5, Service Manager 9.31, Service Manager 9.32 and later. For more 
information, see the latest Service Manager 9.34 Support Matrix at 
https://softwaresupport.hp.com/group/softwaresupport/support-matrices. 
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Built-in troubleshooting tool (SM Doctor)
Additionally, as of Service Manager 9.32, the server patch includes an installation of the HP Service 
Manager Doctor (SM Doctor) tool. The server patch will install the tool in the <SM server root>\(<SM 
server root>/)smdoctor directory. For information on how to use this tool, see the Guides and reference > 
Troubleshooting > HP Service Manager Doctor section in the Help Center.

Upgrade paths
This server patch must be applied on top of one of the following versions/patch levels of the Service 
Manager server:

 l Service Manager 9.30 GA, and 9.30 Patch/Hotfix

 l Service Manager 9.31, and 9.31 Patch/Hotfix

 l Service Manager 9.32, and 9.32 Patch/Hotfix

 l Service Manager 9.33, and 9.33 Patch/Hotfix

 l Service Manager 9.34 GA, and 9.34 Patch/Hotfix

The following server upgrade paths are recommended:

 l New customers: Install the Service Manager 9.30 GA server, and then directly apply this server 
patch.

 l Existing SC6.2, Service Manager 7.11 and  9.21 customers:  Uninstall the old server, install the 
Service Manager 9.30 GA server, and then apply this server patch.

 l Existing Service Manager 9.30,  9.31,  9.32, 9.33 and 9.34 customers: Apply this server patch.

The installation steps are similar to those of Service Manager 9.34. For installation instructions of the 
Service Manager 9.34 server, see the Service Manager 9.34 Upgrade Documentation Center, which is 
available to download from the following HP Software Manuals website: 

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM01042968         

For installation instructions of the server patch, see "Server patch installation steps" on the next page.
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Compatibility mode for installation on Windows Server 
2012
As of Service Manager 9.32, Windows Server 2012 is supported. Be aware that compatibility mode is 
required for installing the Service Manager 9.30 GA server on Windows Server 2012 (not required for 
Windows Server 2008). To run your server installation in compatibility mode, do the following:

 1. Right–click the server's setupwin32.exe file icon.

 2. Click Properties > Compatibility.

 3. Click Run this program in compatibility mode for, and then select Windows Vista (Service Pack 
2).

 4. Click Apply, and then click OK.

 5. Run the setupwin32.exe file to complete the installation.

When you uninstall your server on Windows Server 2012, you should also use compatibility mode. To do 
this, set your Windows server uninstaller file (_uninst\uninstaller.exe) to compatibility mode as 
described above, and then uninstall the server using the uninstaller or Control Panel.

Server patch installation steps

Caution: 
 l The server patch will upgrade your embedded Tomcat to version 6.0.37, and therefore requires 

additional steps.

 l The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2. 

 l For Windows and Linux,  the embedded JRE has already upgraded to version 8; for other Unix-
based platforms, you need to manually perform this JRE upgrade. 

The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint 
does not support Server Name Indication (SNI), which is by default activated in JRE 7 and JRE 8. 
Once Service Manager is upgraded to use JRE 7 orJRE 8, it starts to use SNI extensions during 
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the SSL handshake. If the remote endpoint does not support SNI, the web service call will fail 
with an error message. To solve this issue, do either of the following: 

 n Activate SNI at the remote end point (recommended)

 n If the remote endpoint does not support SNI extensions, and SNI cannot be activated, add 
the following JVMOption<n> parameter either to the sm.ini file, or to the start command of 
the servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

Note: If you have a horizontally-scaled system, you must upgrade all your server instances.

To install the new sever patch, follow these steps:

 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backup and backout instructions" on 
page 36.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.37 when 
you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory. 

Note: This step is required only when you are upgrading from a server version earlier than 
9.31p2. This is to avoid conflicts between the old 1.6-based JRE and new 1.7-based JRE.

 7. Extract the compressed files for your operating system into the main Service Manager directory on 
the server. By default, the file is saved in C:\ProgramFiles\HP\Service Manager 9.34\Server.

 8. For UNIX servers, set the file permissions for all Service Manager files to "755."

 9. For the following Unix servers, manually upgrade to one of the following JRE versions, if you have 
not already done so.
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 a. Install an appropriate version of JRE for your platform.

Solaris JRE 7 (update 80 or greater)

HP-UX JRE 7 (JRE_7.0.12 or greater) or JRE 8 (JRE_8.0.04 or greater)

AIX JRE 7 (SR8 or greater) or JRE 8 (SR2 or greater)

Tip: You can check the JRE version on AIX by running the $<JRE_INSTALL_
DIR>/bin/java -version command, in which <JRE_INSTALL_DIR> is the JRE 
installation directory. If you are working with JRE 8, make sure that the system 
outputs consist of the following line:

Java(TM) SE Runtime Environment (build pap3280sr2fp10-20160108_
01(SR2 FP10))

 b. Set your JAVA_HOME environment variable to point to JDK (if you have JDK installed) or JRE (if 
you have only JRE installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links.

 d. Run the following command to check that the JRE version is correct: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them in 
the new RUN/tomcat folder.

 11. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been 
updated to a newer version. Either keep your old file by copying it back or keep the updated 
version (a KM knowledgebase full reindexing is then required).

 12. Run the sm -unlockdatabase command.

Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required 
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The 
purpose of this step is to prevent stale license information from being kept in the system. In a 
scaling implementation, you can run this command from any one of your servers.

 13. Restart the Service Manager server.
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 14. Restart the Service Manager clients.

 15. Verify the version using either of the methods:

 n From the Windows client, click  Help > About Service Manager Server. The server version should 
be: Release 9.34.5003 build P5. 

 n From the server's RUN folder, run the sm -version command. The server version should be: 

Version: 9.34.5003 

Patch level: P5 

Web tier installation
The web tier update consists of a compressed file, sm9.34.5003-P5_Web_Tier.zip, which contains the 
installation files (both the .war and .ear files) that are required to install the HP Service Manager 9.34-
P5 web tier. Installing the new web tier will upgrade your web client to this release level.

For installation instructions, see the SM9.34 Upgrade Documentation Center, which is available to 
download from the following HP Software Manuals website: 

https://softwaresupport.hp.com/km/KM01042968

New customers
You only need to install the new web tier using the .war or .ear file from the sm9.34.5003-P5_Web_
Tier.zip file in this release. 

Existing customers
To upgrade your web tier to this patch level, you must back up and uninstall your old web tier, and then 
install the new web tier.  The upgrade does not automatically save your web tier customizations. To keep 
your changes, you must back up your customized files and restore your customizations in the new 
deployment.

Note: If you plan to deploy the web tier on Tomcat 7.0 by using the Tomcat Manager, you must set 
the max-file-size and max-request-size parameters (default: 52428800) in the <Tomcat 7.0_
Home>webapps\manager\WEB-INF\web.xml file to a value greater than the size of the web tier 
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.war file, otherwise the deployment request will be rejected because the web tier .war file exceeds 
the default maximum values. This restriction does not exist in Tomcat 6.0.

To install the new web tier, follow these steps:

 1. Make the necessary backups. For more information about how to do this, see "Backup and backout 
instructions" on page 36.

 2. Delete or uninstall the existing web tier .war (or the .ear) file.

 3. Clear the cache of your web application server.

 4. Deploy the new webtier-9.34.war (or .ear) file by following the instructions in the Service Manager 
9.34 Upgrade Documentation Center.

Note: It is best practice to deploy with a unique context root, for example, /webtier-9.34.5003-
P5.

 5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to 
ensure that any new parameters are properly merged into the files used in your final deployment. 
Do this for application-context.xml as well as any other files you may have customized (such as 
style sheets and splash screens).

 6. Make any new customizations that are necessary for your deployment.

 7. Restart the web application server.

 8. Check the version by clicking the HP logo (About HP Service Manager) icon.

The web tier version should be: 9.34.5003-P5.

Windows Client Installation

Note: No features are being added to the Service Manager Windows (Eclipse) client.  HP 
recommends that Service Manager administrators deploy one of the other three clients (web 
client, SRC client or Mobility client) to end users.  You still need the Windows client to perform 
administrative tasks.
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The Windows client update consists of a compressed file, sm9.34.5003-P5_Windows_Client.zip, which 
contains the executable installation files of the new Windows client. Installing the new Windows client 
will upgrade your Windows client to this release level.

For installation instructions, see the SM9.34 Upgrade Documentation Center, which is available to 
download from the following HP Software Manuals website: 

https://softwaresupport.hp.com/km/KM01042968

New Customers
You only need to install the new Windows client.

Existing Customers
You need to back up and uninstall the old Windows client, and then install the new Windows client. 

To install the new Windows client:

 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backup and backout instructions" on page 36.

 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)

 4. Run setup.exe from this Windows client patch to install the new client.

 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.34.5003-P5.

Windows Client Configuration Utility installation
This release includes an updated version of the Windows Client Configuration Utility (sm9.34.5003-P5_
Windows_Client_Configuration.zip). This version comes with an embedded JRE 8.

For installation instructions, see the Service Manager 9.34 Upgrade Documentation Center, which is 
available to download from the following HP Software Manuals website:

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM01042968
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Applications Update installation
This release does not contain an applications or upgrade package. The latest applications version is 
9.34. An applications upgrade is optional, and you can install the Service Manager 9.34 Applications or 
Upgrade package according to your current applications version.

You can find the download links for the SM 9.34 Applications or Upgrade package as well as Release 
Notes from knowledge document Overview of Service Manager 9.3x Releases:

https://softwaresupport.hp.com/km/KM00705452

Application unload installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant 
issue, an unload file is provided. Unload files introduced in earlier patches are also included in this 
cumulative release. If you have not already applied them for a previous patch, you should also apply the 
unload files that are intended for your applications version. For more details about these applications 
updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract 
sm9.34.5003-P5_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order, unless otherwise specified.

Unload file naming convention

The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, 
QCCR1E12345. 

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 
2 and should be used for patch 2 or higher.
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Note: Sometimes this portion contains an additional hot fix number, for example, 
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 patch 
16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, 
which means the unload file is intended only for Service Manager applications version 7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 
example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 9.20, 
and 9.30 (which are compatible with Service Manager server 9.30), unless otherwise specified in 
the unload file description. For information on the applicable applications versions for each 
unload file included in the current patch, see Unload Files Included in the Current Patch.

Unload files included in the current patch

The following are unload files included in the current patch release.

Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E114378_
SM934P2_
SM932.unl

9.34p2 9.34 Fixes this issue: The Auto complete feature needs 
RTE to change the line value of"cursor.line to the 
value of the line when calling 
cursor.field.name.set.

Associated server fix: QCCR1E114378

QCCR1E112815_
SM934P1_
SM934.unl

9.34p1 9.34 Fixes this issue: The Time Period Management 
menu and sub-menus are not displayed after 
upgrading to Service Manager 9.34.

Associated server fix: QCCR1E112815

QCCR1E103456_
SM934_SM932.unl

9.34 9.32 Fixes this issue: When you use the "Any of these 
words" text search option to export records to 
Excel or to a text file, some records are not 
exported.

Associated server fix: QCCR1E103456

Patch 5 Release Notes
Installation notes

HP Service Manager (9.34) Page 54 of 68



Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E103581_
SM934_SM932.unl

9.34 9.32 Fixes this issue: The auto complete feature is not 
supported by the web client.

Associated server fix: QCCR1E103581

QCCR1E106292_
SM934.unl

9.34 7.11 - 9.34 Fixes this issue: The globallist and locallist files 
are not cached. This causes heavy database 
traffic during the login process, especially when 
the globalist or locallist file is large.

Associated server fix: QCCR1E106292

QCCR1E99147_
SM933_SM930.unl

9.33 9.30, 9.31, 
and 9.32

Fixes this issue: The first tab of a Notebook is 
reset to be the active tab when a new interaction 
is opened through the "Return to blank 
interaction" environment settings.

Associated server fix: QCCR1E99147

QCCR1E99398_
SM932P2.unl

9.32p2 7.11, 9.21, 
9.30, and 
9.31

Enables the inactivity timer function to work 
correctly when the version of applications is lower 
than the version of the server.

Associated server fix: QCCR1E99398

QCCR1E19946_
SM933.unl

9.33 7.11, 9.21, 
9.30, 9.31, 
and 9.32

Enables extra columns in the "Attachments" 
section of records.

Associated server fix: QCCR1E19946

QCCR1E31324_
SM932.unl

9.32 7.11, 9.21, 
9.30 and 
9.31

Fixes this issue: With Syslog audit turned on, only 
a syslog record showing login is created; no 
record for logoff is recorded if the user does not 
log out "normally."

Associated server fix: QCCR1E31324

QCCR1E96802_
SM931P3.unl

9.31p3 7.11, 9.21, 
9.30 and 
9.31

Changes the behavior when handling web service 
request user passwords. See the Service Manager 
9.31p3 Release Notes.

Associated server fix: QCCR1E96802

Patch 5 Release Notes
Installation notes

HP Service Manager (9.34) Page 55 of 68



Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E52767_
SM931P3_
SM930.unl

9.31p3 9.30 Fixes this issue: Users cannot add data policy 
definitions on joined tables. 

Note: You do not need to load this unload if 
you are running on Service Manager 9.31, 
9.21, or 7.11 applications.

Associated server fix: QCCR1E52767

QCCR1E76724_
SM931P2_
SM930.unl

9.31p2 9.30 and 
9.31

Fixes this issue: After deleting the unique key of 
cm3r, a signal 11 happened while doing an IR 
regeneration.

Associated server fix: QCCR1E76724

QCCR1E76227_
SM930P6_
SM930.unl

9.31 9.30 Contains the code changes to support localization 
of incident/change priority and urgency strings 
for the 9.31 Mobility Client.

Note: Not needed for the Service Manager 
9.32 or later Mobility client.

QCCR1E78794_
SM930P6_
SM930.unl

9.31 9.30 Removes incident.assignee when a Web Service 
call specifies the assignee as 'NULL' through the 
Service Manager9.31 Mobility Client.

Note: Not needed for the Service Manager 
9.32 or later Mobility client.

QCCR1E76796_
SM930P6_
SM930.unl

9.31 9.30 Provides the ability to turn on debugging 
dynamically for user sessions or schedulers.

Note: This unload requires the Service 
Manager 9.31 server.

QCCR1E71099_
SM930P5_
SM711.unl

9.30p5 7.11 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns.

Associated server fix: QCCR1E71099
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Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E71099_
SM930P5_
SM920.unl

9.30p5 9.20 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E71099_
SM930P5_
SM930.unl

9.30p5 9.30 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E71139_
SM930P5_
SM930.unl

9.30p5 9.30 Works with server fix QCCR1E71139 to solve this 
issue: When Service Manager is configured to use 
LDAP as the authentication data source, the user 
is still forced to change the password if the user 
is expired in the local database.

QCCR1E31941_
SM930P4_
SM930.unl

9.30P4 9.30 Enables users to use a pre-configured decimal 
symbol when completing numeric fields. 

Note: This enhancement requires a 9.30p4 or 
later server; however if you are using RTE 
version 9.30 with applications version 7.11 or 
9.20, do not load this unload file; you can 
safely upgrade your server to 9.30p4 or later 
without applying this applications change.

Associated server fix: QCCR1E31941.

QCCR1E73452_
SM930P4.unl

9.30P4 7.11 - 9.30 Enables Mandanten restricting queries to be 
updated correctly after a profile is edited.

Associated server fix: QCCR1E71897
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Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E67072_
SM930P4_
SM930.unl

9.30P3 7.11 and 
9.20

Enables users to take advantage of the new 
KMStatusListener background process.

Note: This unload file is not needed for 
applications version 9.30 or later, which 
supports only the Solr Search Engine.

Associated server fix: QCCR1E67071

QCCR1E70163_
SM930P4_
SM711.unl

9.30P3 7.11 Fixes this issue: The KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E70163_
SM930P4_
SM920.unl

9.30P3 9.20 Fixes this issue: The KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E70163_
SM930P4_
SM930.unl

9.30P3 9.30 Fixes this issue: The KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E67647_
SM930P3.unl

9.30P3 7.11 - 9.30 Updates the exception message that occurs in 
the request response when closing an interaction 
by calling CloseInteraction from a web service 
without specifying the localSolution field in the 
request.

Associated server fix: QCCR1E54192

QCCR1E67610_
SM930P2.unl

9.30P2 7.11 - 9.30 Enables you to block potentially dangerous 
attachments.

Associated server fix: QCCR1E64290

Loading unload files

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended 
to use Unload Manager to load an unload file, because Unload Manager can help you create a 
backup of your old data and reconcile conflicts during the installation of the unload; if your 
application version is other than any of these, Unload Manager is not available and you can use 
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Database Manager instead. 

To load an unload file using Unload Manager, follow these steps:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of 
the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager, follow these steps:

 1. Make sure the Windows client is configured for server-side load/unload.

 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking 
List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backup and 
backout instructions" on page 36.
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 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this field 
blank.

File Type Select the source operating system of 
the unload file.

Messages Option —  

All Messages Select this option to see all messages 
that Service Manager generates loading 
the file.

Messages Option —  

Totals Only Select this option to see only the total 
number of files Service Manager loads.

Messages Option — None Select this option to hide all messages 
that Service Manager generates when 
loading the file.

 7. Click Load FG.

Service Request Catalog (SRC) installation
Service Manager 9.34.p5 includes the SRC package (src9.34p5.0011.zip), which contains the following 
files:

 l a .war file for SRC 9.34.p5 (src-9.34p5.war)

 l Unload files for SRC 9.34.p5 and previous versions 

Unload file naming convention

The unload files use the following naming convention: <CR_ID>_SRCxxxPxx_SMxxx.unl, where:
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 n <CR_ID>: The identification number of the applications defect that the unload file fixes. For 
example, QCCR1E12345. 

 n SRCxxxPxx: The minimum SRC patch level that requires the unload file. For example, SRC934p2, 
which means the unload file comes with the SRC9.34 patch 2 and should be used for patch 2 or 
higher.

Note: Sometimes this portion contains an additional hot fix number, for example, 
SRC934p2HF1. This example means the unload file is intended for SRC934 patch 2 Hot Fix 1 
or higher.

 n SMxxx: The SM applications version that requires the unload file. For example, SM934, which 
means the unload file is intended only for Service Manager applications version 9.34.

Unload files included in the SRC 9.34 patches

The following are unload files included in the SRC 9.34 patch releases.

Unload file

Introduced 
in  9.3x 
patch

Used 
for 
apps 
version
(s) Description

QCCR1E106361_
SRC934p2_
SM934.unl

SRC9.34.p2 9.34 Fixes this issue: Multiple selection is not supported in a 
Lookup window in SRC when you submit a request for 
Service Catalog items.

Associated SRC fix: QCCR1E106361

QCCR1E108784_
SRC934p2_
SM934.unl

SRC9.34.p2 9.34 Fixes this issue: When the SRC login session number 
exceeds the operator's max logins, the following 
unfriendly error message is displayed:

Error:Unexpected Exception: Runtime error or 
exception incurred in server. Please contact 
your Administrator

Associated SRC fix: QCCR1E108784
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Unload file

Introduced 
in  9.3x 
patch

Used 
for 
apps 
version
(s) Description

QCCR1E89679_
SRC934p3_
SM934.unl

SRC9.34.p3 9.34 Fixes this issue: After catalog items  synchronized to 
SRC, inactive catalog items are still available in the 
auto-completed hint list of the Search box in the Tab 
header in SRC.

Associated SRC fix: QCCR1E89679

QCCR1E129134_
SRC934p5_
SM934.unl

SRC9.34.p5 9.34 Fixes this issue: SRC does not allow the "request for" 
person to update or cancel the Support Requests from 
the SRC user interface.

Associated SRC fix: QCCR1E129134

QCCR1M2359_
SRC934p5_
SM934.unl

SRC9.34.p5 9.34 Fixes this issue: SRC does not allow the cancellation of 
Service Requests from the SRC user interface.

Associated SRC fix: QCCR1M2359

Before you proceed, download the Service Request Catalog 9.34 Interactive Installation Guide and Service 
Request Catalog 9.34 Customization Guide from HP Software Support.

Note: Users who want to use Service Request Catalog on their tablet devices can download the 
HP Service Request Catalog app to their device from Google Play or the Apple Appstore. To locate 
these apps, search for "HP SRC" in the appropriate store.

New Customers

 1. Install SRC 9.34.p5, deploy the src-9.34p5.war file by following the instructions in the Service 
Request Catalog 9.34 Interactive Installation Guide.

 2. If there are unload files in the SRC zip package, you must load them into Service Manager by using 
Unload Manager.

Note: Make sure to install unload files for previous patches at first if they have not been 
loaded to Service Manager.
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 3. Configure SRC 9.34.p5 by following the instructions in the Service Request Catalog 9.34 
Customization Guide.

Existing Customers

 1. Install SRC 9.34.p5, as described above.

 2. Migrate the customizations from your old deployment to SRC 9.34.p5. 

Mobile Applications  installation
Service Manager 9.34-P5 includes a new version of the Mobility client (sm9.34.5001_Mobility.zip). New 
customers can directly install the new Mobility client by deploying the webapp-9.34.5001.war file, while 
existing customers can only uninstall their old Mobility client and then install the new one.

Installation Steps

Note: The Service Manager 9.34 Mobility client supports Apache Tomcat 7.0 (7.0.54 or greater) and 
and IBM WebSphere 8.5 (8.5.5 or greater) web application servers. 

For more information about how install the Service Manager 9.34 Mobility client, refer to  the Service 
Manager 9.34 Mobile Applications User Guide.

Application changes required for SM9.31 and for SM9.30

The Service Manager 9.34 Mobility client can work with the SM9.34, SM9.33, SM9.32, SM9.31, or SM9.30 
applications; however, if using the SM9.31 or SM9.30 applications, before users can use the Mobility 
client, you  need to make additional application changes by either importing or manually implementing 
the unload file shipped with the Mobility client package (be sure to import or implement them in listed 
order):

 l mobile2-update-9.30-9.31.unl 

 l mobile2-new-9.30-9.31.unl (If using the SM9.31 or SM9.30 applications with PDCP4 applied, load 
mobile2-new-9.31-pd4.unl instead)

For details, see the Service Manager 9.34 Mobile Applications User Guide.
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Knowledge Management (KM) update installation
This release does not contain any KM updates. You can download the latest KM package shipped with 
the Service Manager 9.34 release.

You can find the download links for the SM9.3x patches and release notes from knowledge document 
Overview of Service Manager 9.3x Releases:

https://softwaresupport.hp.com/km/KM00705452

ODBC Driver update installation
This release does not contain any ODBC Driver updates. The latest ODBC Driver package  has been 
shipped with the HP Service Manager 9.30p4,  9.30p5, and  9.31 releases.

You can find the download links for the SM9.3x patches and release notes from knowledge document 
Overview of Service Manager 9.3x Releases:

https://softwaresupport.hp.com/km/KM00705452

Language pack installation
This release does not contain any language pack updates. You can download the latest language packs 
shipped with the HP Service Manager 9.34 release.

You can find the download links for the SM9.3x patches and release notes from knowledge document 
Overview of Service Manager 9.3x Releases:

https://softwaresupport.hp.com/km/KM00705452

Online help installation
This release does not contain any online help updates. You can download the latest online help shipped 
with the HP Service Manager 9.34 release.

Service Manager 9.34  includes only an English version of the online help. For installation instructions, 
see the Service Manager 9.34 Interactive Installation Guide that is included in the Service Manager 9.34 
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Upgrade Documentation Center. This is available to download from the following HP Software Manuals 
website: 

https://softwaresupport.hp.com/km/KM01042968 

You can download the Service Manager 9.34 Help Center from the following website:

https://softwaresupport.hp.com/km/KM01043155 
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Service Manager support matrix and applications 
content compatibility matrix
The Support Matrix lists supported versions of operating systems, browsers, HP Software products, and 
other compatibility and support information.

The Applications Content Compatibility Matrix (named Compatibility Matrix for Service Manager 
Applications Content) provides compatibility information for Service Manager applications content 
packs (for example, Process Designer Content Packs). 

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go 
to Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Support Matrix and Applications Content Compatibility Matrix, follow these steps:

 1. Use a browser to navigate to the following support matrices web page on HP Software Support 
Online (SSO):

https://softwaresupport.hp.com/group/softwaresupport/support-matrices

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an 
email client is configured on this system, click the link above and an email window opens with the 
following information in the subject line:

Feedback on Patch 5 Release Notes (Service Manager 9.34)

Just add your feedback to the email and click send. 

If no email client is available, copy the information above to a new message in a web mail client, and 
send your feedback to ovdoc-ITSM@hp.com.

We appreciate your feedback!
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